
 

Megapixel FireWire Camera 
User’s Manual 
Release 3.2 

 

Copyright © 2000–2004 PixeLINK.  All Rights Reserved. 
 
 

PixeLINK 
3030 Conroy Road • Ottawa, Ontario • K1G 6C2 • Canada • Tel: (613) 247-1211 • Fax: (613) 247-2001  

Email:  info@pixelink.com • Web Site:  www.pixelink.com 



ii   

PixeLINK™ Megapixel FireWire Camera  
User’s Manual 

Copyright Notice 
Release 3.2 
Copyright © 2000–2004, PixeLINK.  All rights reserved. 
This document contains proprietary and confidential information of PixeLINK.  The contents of this document may not be copied 
nor duplicated in any form, in whole or in part, without prior written consent from PixeLINK. 

By purchasing this product, the Purchaser(s) and/or any subsequent legitimate owner(s) of the product, henceforth referred to as 
“the Purchaser,” agree(s) to abide by the terms of this Agreement and read and recognize the following set of definitions 
appertaining to the intellectual-property items and trademark references as can be found throughout this User’s Manual. 

PixeLINK provides the information and data included in this document for the Purchaser’s benefit, but it is not possible for PixeLINK 
to entirely verify and test all of this information in all circumstances, particularly information relating to non-PixeLINK manufactured 
products.  PixeLINK makes no warranties or representations relating to the quality, content, or adequacy of this information.  Every 
effort has been made to ensure the accuracy of this manual; however, PixeLINK assumes no responsibility for any errors or 
omissions in this document.  PixeLINK shall not be held liable for any errors or for incidental or consequential damages in 
connection with the furnishing, performance, or use of this User’s Manual or the examples herein. 

PixeLINK assumes no responsibility for any damage or loss resulting from the use of this User’s Manual, loss or claims by third 
parties which may arise through the use of this product, any damage or loss caused by deletion of data as a result of malfunction 
or repair, or any other damage related to the use of this product or associated documentation.  The information in this document is 
subject to change without notice. 

Definitions of Intellectual Property and Trademark Attributions 

This Section is intended to ensure proper attribution and honoring of any and all trademarks and intellectual-property items in 
terms of attribution to their respective owners as mentioned in this User’s Manual.  The reader is encouraged to consult this 
Section whenever uncertainty presents itself as to the terms, their meaning within the User's Manual, and the trademarks and 
intellectual-property items they stand to identify, whether by themselves or in conjunction with other terms and items. 

PixeLINK is either a trademark or a registered trademark of PixeLINK in Canada and/or other countries; IEEE is a registered 
trademark or service mark of the Institute of Electrical and Electronics Engineers, Incorporated in the United States and/or other 
countries; FireWire is a trademark of Apple Computer, Inc., registered in the U.S. and other countries; Mic osoft, DirectShow and
Windows are either trademarks or registered trademarks of Microsoft Corporation in the United States and/or other countries; TIFF 
is a trademark or registered trademark of Adobe Systems Incorporated in the United States and/or other countries; TWAIN is a 
trademark or registered trademark of the TWAIN Working Group in the United States and/or other countries.  All other products, 
brand names, company names are trademarks or registered trademarks of their respective owners. 
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Definition of Terms 

This Section is intended to define certain terminology used in this User’s Manual, while ensuring proper attribution and 
honoring of any and all trademarks and intellectual-property items in terms of attribution to their respective owners as 
mentioned in this User’s Manual. 

The Purchaser shall hereby recognize the following definitions set herein, as can be found throughout this User’s Manual: 
Camera shall henceforth refer to a PixeLINK Megapixel FireWire Camera or Imaging Module; Kit shall henceforth refer to a 
PixeLINK Camera Kit; API shall henceforth refer to a PixeLINK Camera Application Programming Interface; FireWire and 1394 
shall henceforth refer to the IEEE 1394a interface specification; DirectShow shall henceforth refer to the Microsoft DirectShow 
multimedia software; Pentium shall henceforth refer to an Intel Pentium microprocessor; Windows shall henceforth refer to a 
Microsoft Windows operating system. 

The above Sections set forth Terms and Conditions, compliance with which constitutes a mandatory prerequisite for owning and/or 
using the product for which the manual was created.  It is the Purchaser’s responsibility to ensure that the information contained 
within the Sections is maintained as a part of the User’s Manual at all times—should the Purchaser discover that the page(s) 
containing the Sections is (are) missing, and/or was not provided with the User's Manual, and/or become illegible, PixeLINK should 
be contacted as soon as possible and the Sections requested.  PixeLINK shall not be held liable for any and all copyright violations 
that may ensue in relation to its products and/or the consequences of their intended and unintended usage. 
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Federal Communications Commission (FCC) Statement  
This equipment has been tested and found to comply with the limits for a Class B digital device, 
pursuant to part 15 of the FCC Rules.  These limits are designed to provide reasonable protection 
against harmful interference in a residential installation.  This equipment generates, uses and can 
radiate radio frequency energy and, if not installed and used in accordance with the instructions, may 
cause harmful interference to radio communications.  However, there is no guarantee that interference 
will not occur in a particular installation.  If this equipment does cause harmful interference to radio or 
television reception, which can be determined by turning the equipment off and on, the user is 
encouraged to try to correct the interference by one or more of the following measures: 

� Reorient or relocate the receiving antenna. 
� Increase the separation between the equipment and receiver. 
� Connect the equipment into an outlet on a circuit different from that to which the receiver 

is connected. 
� Consult the dealer or an experienced radio/TV technician for help. 

Properly shielded and grounded cables and connectors must be used to meet FCC emission limits.  
PixeLINK is not responsible for any radio or television interference caused by using other than 
recommended cables or connectors.   

Unauthorized changes or modifications to the equipment could void the user’s authority to operate the 
equipment. 

This device complies with part 15 of the FCC Rules.  Operation is subject to the following two 
conditions:  (1) This device may not cause harmful interference, and (2) this device must accept any 
interference received, including interference that may cause undesired operation. 

European Community (CE) Statement 
Directives:  2001/95/EC (General Product Safety Directive)—Self-declared 
 89/336/EEC (EMC Directive)  

Standards to which conformity is declared:   
 EN55024:  1998 
 EN55022:  1998 For Class B 

 EN61000-3-2:  1995 
 EN61000-3-3:  1995 

Manufacturer’s Name and Address:  PixeLINK 
 3030 Conroy Road, Ottawa, Ontario, K1G 6C2, Canada  

Type of Equipment:  PixeLINK Megapixel FireWire Camera 

Model Number:  Originally tested on PL-A642; also applies to models with no 
material difference, that is, PL-A641, PL-A661, PL-A662 

First Year of CE Conformity:  2001 (PL-A642) 

This is to certify that the PixeLINK Megapixel FireWire Camera meets or exceeds the standards for CE 
compliance per the Council Directives noted above.  Pertinent testing documentation is available for 
verification. 
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Introduction 

 1.1 The PixeLINK Megapixel FireWire Camera 

PixeLINK 1.3 Megapixel FireWire (IEEE 1394) Cameras offer a fast and affordable 
means of viewing and capturing high quality color or monochrome images on a desktop 
or laptop computer.  With a single FireWire cable, the camera receives power and 
communicates with the computer, providing real ease of use.   

Included with each camera is PixeLINK Capture, a software package that provides 
snapshot image capture and video capture button along with easy-to-use graphical 
controls for adjusting the camera’s imaging parameters, such as exposure, white balance 
and Region of Interest (ROI).   

Images can also be captured directly into popular third-party software packages that use 
TWAIN—applications such as Microsoft Word, Adobe Photoshop and CorelDRAW—as well 
as packages that have been customized specifically for PixeLINK cameras. 

Table 1.1 PixeLINK Megapixel FireWire Camera Models 

Camera Type   
Cameras Color Monochrome 

PL-A661   

PixeLINK Release 3.2 

PL-A662   

PL-A641   
PL-A642   

 

PixeLINK Imaging Modules   

Most sections of this User's Guide also apply to PixeLINK Megapixel Imaging 
Modules (Board-Level Cameras).  See Appendix D (page 44) for more information. 
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 1.2 Topics Covered in this Manual 

This manual describes the functionality of the PixeLINK Megapixel FireWire Camera 
hardware and the PixeLINK Capture software application.   

Users should consult this manual 
… before installing the Camera hardware or software 
… as a guide when using PixeLINK Capture 
… for tips on using the camera with TWAIN-enabled third-party software 

Sections include: 
� Installation of the camera hardware and software—Section 2 
� Features of the camera hardware—Section 3 
� Features and operation of PixeLINK Capture—Section 4 
� An overview of PixeLINK Capture TWAIN compatibility—Section 5 

References in the PDF version of this manual are hyperlinked for easy navigation and 
access. 

 1.3 System Requirements 

One of the following Microsoft Windows operating systems must be installed: 

� Windows 98 Second Edition (SE) 
� Windows 2000, with Service Pack 1 (SP1) installed 
� Windows XP, with Service Pack 1 (SP1) installed 
Service Packs are available for download from the Microsoft Web Site, 
http://www.microsoft.com/

Hardware requirements: 

� Microprocessor: 
Recommended—Pentium® 4 or equivalent, 1.5 GHz  
Minimum—Pentium® III or equivalent, 450 MHz 

� Memory: 
Recommended—128 MB RAM 
Minimum—64 MB RAM 

� Desktop resolution:  
Recommended—1280 × 1024 
Minimum—VGA (640 × 480) 

� 30 MB of hard drive space 
� A video card with 24-bit or 32-bit True Color graphics capability, at least 8 MB of 

video memory and the latest vendor driver installed 
� An installed FireWire OHCI compatible interface or one empty PCI slot. 
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Laptop Computers Only 

Because of the specialized hardware configurations of laptop computers, they require 
additional installation considerations: 
� A preinstalled FireWire Cardbus card or a built-in FireWire port 
� An external 12 V DC power supply—Check the connectors on the FireWire 

Cardbus card or built-in FireWire port.  If the connectors have six pins, the 
FireWire cable may be able to supply the necessary power to the camera (refer 
to the computer’s documentation for confirmation).  If the connectors have four 
pins, the Camera will need an external power supply.     

PixeLINK provides accessory kits for both FireWire enabled laptops (product number 
PL-1394-LAPTOP-ACC) and laptops without FireWire ports (product number 
PL-LAPTOP-ACC).  Please contact your local PixeLINK dealer for more information. 

 1.4 OEM Customizability 

Custom applications can be created for the camera by using the PixeLINK Camera 
Application Programming Interface (API).  This API is available in all PixeLINK Megapixel 
FireWire Camera Developer's Kits and as a standalone Software Development Kit (SDK).  
Please contact your local PixeLINK product vendor for more information on pricing and 
availability of PixeLINK Developer’s Kits and SDKs. 

The camera can also be controlled by some Microsoft DirectShow applications.   

 1.5 Third-Party Applications 

PixeLINK Cameras can be used with a variety of third-party applications.  

� Specialized Applications:  Several manufacturers have designed their software 
specifically to work with the unique features of PixeLINK cameras.  For a current list 
of these applications, visit the PixeLINK Web site at http://www.pixelink.com/. 

� Home and Office Applications:  Many popular programs, such as Microsoft Word, 
Adobe Photoshop and CorelDRAW, use a TWAIN interface to allow basic camera 
control and image capture from within the application software.  For more 
information, See Section 5 (on page 37). 

� Multimedia Applications:  PixeLINK cameras can be controlled by some custom 
applications using Microsoft DirectShow.  

 1.6 Camera Accessories 

Accessories such as tripod mounts, lenses, laptop accessory kits and foot-switches are 
available from PixeLINK.  For a current list of accessories, visit the PixeLINK Web site at 
http://www.pixelink.com/ or contact your PixeLINK vendor. 
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 1.7 Related PixeLINK Documentation 

• PixeLINK Megapixel FireWire Camera System Guide 
This Guide provides a reference for the hardware and system properties of the 
PL-A661 and PL-A662 cameras and related imaging modules (PL-A653 and PL-A654).   

Users should consult this Guide … 
… when mounting a camera within a system or enclosure 
… before using the enhanced features of an imaging module, such as a flash or 

trigger 
… to gain a basic understanding of the relationship between the camera and the 

operating system  

Sections include: 
• A description of the camera (and imaging module) hardware 
• An overview of selected host software and architecture 
• An explanation of Video and Still Modes 

• PixeLINK Camera API Reference, Release 3.2 
This manual provides a reference for the PixeLINK Camera API and related software.   

Sections include: 
• Basics principles of using the PixeLINK Camera API 
• A summary of the PixeLINK Camera API functions 
• Descriptions of individual API functions 
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Installation 

 2.1 Notes on Connecting the PixeLINK Camera 

If you have never installed a FireWire device, read these guidelines before 
connecting the PixeLINK Megapixel FireWire Camera. 

• Install the software before connecting the camera for the first time. 

• You do not need to power down the computer to connect or disconnect a FireWire 
device, nor do you need to reboot after this is done. 

• Do not make more than one connection between the camera and the computer.  If 
you duplicate a connection, the equipment will not be able to communicate properly 
and the system may crash. 

• If you connect more than two FireWire devices, make sure that you do not create a 
functional loop.  This will have the same consequences as making a duplicate 
connection between a single camera and the computer.  For example, if you connect 
device A to device B and device B to device C, you should not connect device A 
directly to device C.  [Note that PixeLINK Capture will not control multiple cameras 
through a single control window.  Other FireWire devices can be used at the same 
time as the camera, up to the capacity of the FireWire bus.] 

• The computer’s FireWire bus can supply power to the camera if the computer has a 
six-pin FireWire connector and the total power demand on the bus does not exceed 
the bus capacity.  Note that some laptops have four-pin FireWire connectors; these 
do not provide power to the camera from the computer.  An external power supply 
can be connected to the FireWire bus.   

 

Note: 

Do not connect the camera before the camera software is installed, or the 
software will not install correctly. 
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 2.2 Installation Procedure 

The Kit is installed in this order: 
1. FireWire Adapter Card (if required)—page 6 
2. PixeLINK Camera Software—page 7 
3. PixeLINK Megapixel FireWire Camera—page 8 

The entire procedure should take only a few minutes.  To avoid problems, please read all 
instructions before you start.  

2.2.1 Installing the FireWire Adapter Card (Desktop Computers) 

Note: 

For Laptops that do not have FireWire capability, use the PixeLINK 
Accessory PL-LAPTOP-ACC. 

An OHCI PCI FireWire (IEEE 1394) adapter card is included in each PixeLINK Megapixel 
FireWire Camera Kit.  If your desktop computer already has a FireWire connector, 
proceed to Section 2.2.2 (on page 7); otherwise, follow the directions below.   

1) Shut down Windows:  Click the Windows Start button, then select Shut Down.  
From the list of options, select “Shut Down”.   

2) When the computer has powered down, disconnect the power cord, keyboard, 
mouse and monitor. 

3) Ground yourself by touching some grounded metal, using an antistatic mat, 
grounding cord or other grounding device, then open the cover of the computer.  

4) Locate an available PCI slot and remove the corresponding slot cover (if present) 
located at the back of the chassis. 

5) Insert the card into the selected PCI slot.  Make 
sure that the card is fitted securely.  Replace the 
cover screw to ground the card firmly to the PC 
chassis. 

6) Replace the cover.  Reconnect the keyboard, 
mouse, monitor and power cord.  Plug in the 
power and switch on the computer  

 

7) Windows 2000 and XP only:  Login to the computer, using an account with 
administrator privileges.     

8) Windows will automatically detect the card and run the "Add New Hardware 
Wizard".  This wizard will search for a "Texas Instruments OHCI Compliant IEEE 
1394 Host Controller".  Click Next. 
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9) Select Search for the best driver for your device.  Click Next.  

10) The wizard will then ask for locations to search for the drivers.  Clear all of the 
check boxes and click Next. 

11) When asked “What do you want to install?” select The updated driver.  Click 
Next.   

12) When the wizard finds the driver, check that the driver location is <Windows 
path>\inf\1394.inf, where <Windows path> is the location of your Windows 
program files.  Click Next. 

If the wizard does not find the driver, it will need to be installed from your 
Windows CD.  When prompted, insert the Windows CD and click OK.  Note that 
if you click too quickly, Windows will not be able to find the driver and it will ask 
you to browse to find it.  Find the driver, select it and continue with the 
installation. 

13) Click Finish to complete the installation of the card. 

14) Proceed to Section 2.2.2 (below) to complete the installation of the Kit. 

2.2.2 Installing the PixeLINK Camera Software 

Windows 2000 and XP only:  To install or uninstall a PixeLINK Camera Kit, you 
must be logged in to an account with administrator privileges.  This is not required 
for usage of the camera.  Contact your system administrator for details.   

1) Exit all applications. 

2) Load the PixeLINK software.  Either: 
• Insert the PixeLINK CD, or  
• Download the PixeLINK camera software from http://support.pixelink.com/. 

3) The interactive installation program will run automatically (see Figure 2.1, on 
page 8).  Click Install This Product to install the software. 

4) Follow the instructions as they appear. 

Note:   

If you receive a message that the Microsoft digital signature was not 
found (see Figure 2.2, on page 8), click Yes.  This will not affect the 
performance of the software or camera.   
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Figure 2.1 Installation Screen 

Figure 2.2 Digital Signature Not Found 

2.2.3 Installing the PixeLINK Megapixel FireWire Camera  

Because the camera uses a FireWire bus, the computer does not need to be switched off 
during camera connection or disconnection.     

1) Login to the computer, if necessary.  (Windows 2000 and XP only:  
Administrator privileges are required for the first connection of a camera 
(“initialization”).) 
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2) Connect the FireWire cable to the camera and the computer’s FireWire port.  You 
may use any available FireWire port on the computer or on the camera for the 
installation.  The operating system will detect the connection automatically.      

Note:  

• If Windows runs the "Add New Hardware Wizard" after you plug in 
the Camera, you are probably running Windows 98 First Edition.  Cancel the 
current installation and install one of the supported Windows operating systems 
listed in Section 1.3 (on page 2). 

• If you receive a message that the Microsoft digital signature was not 
found (see Figure 2.2, on page 8), click Yes.    

3) Windows will load the driver for the camera.  (This driver was installed at the 
same time as the PixeLINK camera software.)  You might need to wait a few 
seconds while Windows builds a driver information database.   

Windows 2000 and XP only: 

4) Run the PixeLINK applications (PixeLINK Capture and PL-A6xx Application 
(Developer’s Kits only)) briefly before logging out.  This will ensure 
initialization of the programs.  It is not necessary to run them under 
administrator privileges during subsequent sessions.  For more information, 
see Section 3.5 (on page 13). 

5) If you have more than one camera, initialize all of them while still using 
Administrator privileges.  Detach the FireWire cable from the current camera 
and connect it to an uninitialized one.  Repeat as required.  Administrator 
privileges are not required for subsequent use of a camera. 

 2.3 Uninstallation of the PixeLINK Camera Software 

1) Exit all applications. 

2) In Windows:  Click Start, then select Programs Æ PixeLINK Æ PL-A6xx (or 
the path selected in the installation procedure, if it is different).   

3) Select the Uninstallation option for the software and follow the instructions given.   
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Camera Hardware 

 3.1 PixeLINK Camera Hardware Overview 

Figure 3.1 The PixeLINK Camera 

� 1.3 Megapixel imager resolution (1280 × 1024) 
� 8/10-bit RGB (col
� Integrated infra-red (IR) filter over the image sensor 

connectors 
2 tpi) [lens not included] 

g fixture (4–40 screws)  

See  page 11) for locations of hardware features.  Note that 
outlines of the PL-A661 
PL- r.   

Detailed drawings includi

Camera Features: 

or) or monochrome pixels 

� Two FireWire 
� Lens mount for a standard C-mount lens (1" × 3
� Mounting holes for a tripod or other mountin

 Figure 3.2 and Figure 3.3 (on
and PL-A662 cameras are shown in these figures; PL-A641 and 

A642 cameras differ in the configuration of the C-mount and infra-red (IR)  filte

ng dimensions are provided in the PixeLINK Megapixel FireWire 
Camera Systems Guide: PL-A630 to PL-A660 Series Cameras. 
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Figure 3.2 Camera Features, Top View 

Figure 3.3 Camera Features, Bottom View 
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 3.2 FireWire Connectors  

Each PixeLINK camera has two FireWire connectors (ports), allowing several FireWire 
devices to be daisy-chained.  The number of devices that may be managed 
simultaneously depends on the total bandwidth and may be limited by the processing 
capabilities of the host computer.  [Note that PixeLINK Capture will control only one 
camera at once.]  

 3.3 Power 

The computer’s FireWire bus can supply power to the camera if the computer has a six-
pin FireWire connector and the total power demand on the bus does not exceed the bus 
capacity.  Some systems—such as laptop computers or those with several FireWire 
devices daisy-chained—require an external 12 V supply to power the camera.   

An external power supply can be connected to the FireWire bus.  (Imaging modules are 
also capable of having an external power supply attached directly to a power header.)   

 3.4 Attaching Lenses and Tripods 

The camera can be fitted with a standard C-mount lens or attached to a microscope with 
a suitable coupler.  Simply attach the lens or connect to the microscope using the 

re 3.2 on page 11. 

Table 3.1 Tripod Mount Selection Table. 

threaded lens mount indicated in Figu

The back of the camera has three 4–40 screw holes for the attachment of a mounting 
fixture such as a tripod. 

PixeLINK offers custom mounting fixtures for attaching a tripod with a standard ¼–20 
screw threading at a 90° angle to the Camera. The tripod mounts are specific to the type 
of camera.  

For this camera … Use this tripod mount: 
PL-A641, PL-642 
PL-A661, PL-662 PL-640/660-CAMERA 1/4-20 MOUNT 

PL-A633, PL-634 
PL-A653, PL-654 PL-MODULE 1/4-20 MOUNT 

 

For more information, contact your PixeLINK vendor or visit the PixeLINK Web site at 
http://www.pixelink.com/. 
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 3.5 IR Filter 

The camera is fitted with an integrated IR filter.   

Minor Cleaning of the IR Filter 

1. Carefully apply puffs of dry, compressed air to move particles off the center of the 
glass. 

2. Remove oils with a swab moistened with reagent-grade isopropyl alcohol.  The swab 

Caution: 

Do not

should be damp but not dripping. 

 

!  use acetone to clean the IR filter. 
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444      
PixeLINK Capture 

 4.1 Introduction 

PixeLINK Capture is a real-time, interactive application for the PixeLINK Megapixel 
FireWire Camera.  Functions include: 

� Viewing a video image 
� Adjusting and setting imaging parameters 
� Capturing images and storing them as bitmap, TIFF, JPEG or raw image data files 
� Capturing AVI video clips 

“What You See Is What You Get” 

PixeLINK Capture works by streaming real-time, high-quality video to a preview 
window in which the image size, color and exposure can be adjusted interactively 
through an easy-to-use control window prior to image capture.   

For the advanced user, PixeLINK Capture also offers options of more complex image 
enhancements as the picture is being captured to disk, such as calculations that involve 
several sequential frames.  

 4.2 Camera Models 

Because PixeLINK Capture is backward-compatible, it works with all PixeLINK Megapixel 
FireWire camera models PL-A631 though PL-A662. Options applicable to specific camera 
types or models are noted. 

 4.3 Starting PixeLINK Capture 

To launch PixeLINK Capture from Windows:   

Click Start, then select Programs Æ PixeLINK Æ PL-A6xx Æ PL-A6xx Capture  
(or the path selected in the installation procedure). 
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If only one camera is connected, PixeLINK Capture will select it automatically.  If more 
than one is connected, the program offers a list of available cameras (see Figure 4.1, 
below).  Select a camera from the list.  

(Because a camera can be controlled by only one application at a time, any cameras that 
are already in use by other applications are ignored.)  

Figure 4.1 Selecting a Camera 

When you first start PixeLINK Capture, the application opens a control window and a 
preview window showing a 640 × 480 image.   

Note: 
PixeLINK Captu e launches with the control settings that were in use when it (or the 
PixeLINK Captu e TWAIN interface) was last closed.   

r
r

 4.4 Using PixeLINK Capture 

PixeLINK Capture allows the quick and easy adjustment and capture of digital images.   

The most frequently used functions are easily accessible in the PixeLINK Capture control 
window.  These functions perform three major tasks: 

Viewing the image (turning the preview image on and off) 
• See Section 4.5 on page 17 

Adjusting the image prope ties, including applying and managing settings and presets  r
• See Section 4.6 on page 17 

Capturing a still image or video clip  
• Still images—See Section 4.7 on page 23  
• Video clips—See Section  4.8 on page 27 

Figure 4.2 (on page 16) provides a quick reference for the functions in the control 
window.  Additional functions and options are available through the menu bar (see 
Section  4.10 on page 29). 
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Basic Procedure for Adjusting and Capturing a Still Image: 
1) Adjust the exposure (near the top of the control window) 
2) Correct the white balance or gain (middle of the window) 
3) Capture the image (buttons on the bottom of the window) 

/  Stop/Start Video  

Set White Balance (Cool/Blue to  
Warm/Red) 

— Manually  
— Based on Region  

               PL-A632, PL-A634 
               PL-A642 only 

— Automatically 

Set Saturation (Mono/0 
  to Full color/1.99) 

Set Gamma (0.01 to 2.00) 

 

To Capture Images 

1 “Save As …”—Specify a name, location and type for the image file.   

2 “Settings …”—Select the Capture Settings Options.   

3 “Snapshot”/"Start"—Capture single/multiple image(s). 

Select Image Size
• 320 × 240  
• 640 × 480 
• 640 × 512 (Full FOV) 

• 800 × 600 
• 1024 × 768 
• 1280 × 1024 

Set Exposure Time (ms) 
— Manually  
— Automatically  
— Continuous Auto  

(AE On) 

Not Shown (Monochrome only) 
Set Gain (Brightness, Dark to Light) 

2 3

Store Camera Settings 
To store settings, click Save  
   and create a setting name.   
To apply settings, select from  
    the drop-down list  

Focus 
Black vertical bar = Best recent focus 
level 
Red horizontal bar = Current focus level  
Manually adjust the focus until the red bar 
    reaches the black bar. 

1 

Figure 4.2 PixeLINK Capture Quick Reference (PL-A662 options shown) 

Note: 

• Not all options are available on all cameras.  Figures show options for the 
PL-A662 color camera/PL-A654 color imaging module. 

• A camera can be controlled by only one application at a time 
• PixeLINK Captu e can control only one camera at a time.   r
• Other FireWire devices can be used at the same time as the camera, up to the 

capacity of the FireWire bus.  If you need to make multiple FireWire connections, 
refer to Section 2.1 (on page 5) for guidelines. 
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 4.5 Viewing the Image 

/  Stop/Start Video (Toggle Button) 

Click to Stop or Start the video display in the preview window.  

The preview window opens when the video display is started and closes when the video 
display is stopped.  By default, the preview window is the same size as the image.   

 4.6 Adjusting the Image 

4.6.1 Selecting the Image Size 

The full field of view (FFOV) of the camera is 1280 × 1024 pixels.  The image can be all 
of this area or a selected portion of it, as shown in Figure 4.3, below. 

(0,0)

(1280, 1024)(0, 1024)

(1280, 0)

Portion
displayed in
the preview
window

Full Field of View

Figure 4.3 The Full Field of View and the Displayed Image 

To select the image size:  From the Size drop-down list, select the desired image size, 
in pixels: 

• 320 × 240  
• 640 × 480 
• 640 × 512 (Full FOV) 

• 800 × 600 
• 1024 × 768 
• 1280 × 1024 

To display the full field of view (FFOV), select:  
• 640 × 512 (FFOV)—Display at quarter resolution (and a higher frame rate) 
• 1280 × 1024—Display at normal resolution  

All other settings represent a portion of the full field of view (see Figure 4.3, above).  
Default:  640 × 480. 
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To reposition the image in the full field of view:  Go to the Options menu and 
select Set Subwindow Position (see page 29).  The current image location appears as 
a red frame superimposed on the full field of view.  Drag the frame to reposition the 
image (subwindow), then click to set the new location.  This simulates a digital pan-tilt 
function. 

This option is not available when the image size is 640 × 512 (Full FOV) or 1280 × 1024, 
since these resolutions represent the full field of view. 

Image size versus preview window size:  By default, the preview window is the 
same size as the image.  However, the preview window can be resized using the usual 
Microsoft window handles or by clicking its Maximize icon.  This does not affect the 
dimensions of the image generated by the camera, so resizing the preview window can 
distort the appearance of the image or make it look pixilated (that is, it can look boxy, 
chunky or jagged).  It can also slow down the performance of the system.  Resizing the 
window has no effect on captured images.    

To reset the preview window to the same size as the image, go to the Options menu and 
select Reset Preview Window. 

4.6.2 Adjusting the Control Settings 

Table 4.1 Image Controls 

Camera Type Range 
Parameter 

Mono. Color Min Max 
Exposure   0 ms PL-A661/PL-A662:  300 ms  

PL-A641/PL-A642:  See Section 4.6.2.1 (p. 18) 
AE On   Darker (1% sat.) Lighter (20% sat.) 

White Balance   Cool (blue) Warm (red) 
Gain (not shown)   0.69 2.74 
Saturation    PL-A662:  Mono (0) 

PL-A642:  Less color (0) 
PL-A662:  Full color (1.99) 
PL-A642:  Full color (1.99) 

Gamma   0.01 2.00 

 

4.6.2.1 Exposure  

(Refer to Figure 4.4 on page 19.)  Increase or decrease the exposure time (in 
milliseconds) by moving the Exposure slider or by entering the exposure time in the box 
below the slider.  (Default: PL-A661 and PL-A662 —50 ms; PL-A641 and PL-A642—25 
ms).  Valid values range from 0 ms to 300 ms for PL-A661 and PL-A662 cameras.  The 
maximum exposure time for PL-A641 and PL-A642 cameras depends on the size of the 
image and the acceleration setting applied (see “Set Video Preview Acceleration to”, on 
page 31).  For these cameras, the maximum exposure time increases when the image 
size is increased and acceleration is not applied (see Table 4.2, below). 

A red triangle above the slider (shown in Figure 4.4, on page 19) appears for 
PL-A661 and PL-A662 Cameras only.  It indicates the maximum exposure time that can 
be used without reducing the frame rate under the current settings. 
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Table 4.2 Examples of Maximum Exposure Time, PL-A641 and PL-A642 Cameras only 

 Video Preview Acceleration Setting  

Image Size 
Accelerated  

(24 MHz) 
Standard 
 (16 MHz) 

Moderate  
(12 MHz) 

640 × 480 33.3 ms 50.0 ms 66.6 ms 
1280 × 1024 71.0 ms 106.5 ms 142.0 ms 

 

Figure 4.4 Exposure Controls 

Auto Exposure:  Click Au matically.  PixeLINK Capture 
adjusts the exposure time to improve the image intensity for viewing.  This option is 

 the video stream.  This control is 

, when AE On is selected, the exposure slider changes 
from a time scale to an indicator of light intensity ranging from Darker to Lighter, and the 
box below the slide  applied (valid values 
range from 1 to 20%).  Default:  Off.  This option is available only while the video display 

to to set the exposure time auto

available only while the video display is running. 

AE On (Continuous Auto Exposure):  Select AE On to adjust the exposure time 
automatically to accommodate continuous changes in
similar to automatic gain control in analog cameras.  This option is not available for 
PL-A641 and PL-A642 Cameras. 

As shown in Figure 4.5 (above)

Figure 4.5 Exposure Controls with “AE On” 

r indicates the percentage of saturation to be

is running.   

Occasionally, due to certain lighting conditions and subject size compared with the 
amount of background illumination, the exposure may cycle from too bright to too dark.  
If this occurs, reduce the amount of background in the image by moving the subject, 
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adjust the exposure slider to another value, or adjust the lens iris or microscope light 
levels (if applicable). 

Of special interest to microscopists:  Continuous Auto Exposure is particularly 
useful when viewing and capturing images with a variety of microscope objectives.   

• Setting the exposure slider to Darker (or 1%) typically gives good results for 
bright field microscopy.   

• The exposure control ignores rapid changes in intensity (from bright to very dark) 
for approximately three seconds, allowing the microscope operator plenty of time 
to switch objectives.   

• When the light intensity is detectable again, the exposure control function 
resumes.  Typically, the correct exposure should be attained in less than one 
second after the objective has been changed.  

onds for the camera to reset the 

4.6.2.2 

About White Balance 
to interpret the color of an object that is 
Some light sources, such as sunlight or 

lightly colored hues 

Manual White Balance  of th
blue  
Defa

e (or light gray) but might be slightly off-colored.  It then adjusts the 

 
b

ire image should be near-white when performing a white balance. 

• If the objective is covered or the illumination is turned off for more than three 
seconds, the camera will attempt to use a longer exposure time.  When the light 
is turned back on, it can take up to four sec
exposure. 

White Balance (Color Cameras only) 

White Balance is the ability of the camera 
illuminated with a particular type of light.  
florescent light, cast s

Recommendation:  Adjust the image exposure and correctly set the light source type 
(page 30)  before performing a white balance.  

: Adjust the color levels e image toward the Cool (more 
) or Warm (more red) ends of the spectrum by moving the White Balance slider. 
ult:  Midpoint. 

Automatic White Balance:  Click Auto to calculate and set the white balance based 
on the color content of the current image. This function detects portions of the image 
that should be whit
color balance of the entire image to optimize the colours of the image compared to those 
seen by the human eye..  This option is available only while the video display is running. 

For the PL-A662 camera, the Automatic White Balance function adjusts the colors based 
on portions of the scene that are near-white.  This gives a more accurate color balance.  
To ensure that the colors can be balanced correctly, a small portion of the image should
e near-white.  

For the PL-A642 camera, the Automatic White Balance function adjusts the colors based 
on the average color of the entire scene.  To ensure that the colors can be balanced 
correctly, the ent
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Of special interest to microscopists: 

• In brightfield microscopy using transmitted light, if the background illumination is 
visible, there is often enough of this illumination for an accurate color balance.  If 
the sample completely fills the image, move the sample to allow a small amount 
of background illumination to show in the image.   Otherwise, the automatic 
white balance will not yield accurate results. 

• In reflected light microscopy, a small portion of the scene must be white for the 
automatic white balance to be accurate.  Place a piece of white paper in the field 
of view when performing the white balance if there is no white present. 

Manual White Point Selection:  The “white point” is the off-white color that appears 
where the image should be white.  This color can be imparted for a number of reasons.  
If this color can be readily identified visually, it can be selected manually for the white 
balance function:  Go to the Options menu and select Set White Point.  (See page 30 
for more information.)    

Area White Balance:  For the PL-A641 camera only:  To calculate and set the color 
levels of the entire image according the levels present in a small area, click the 
“Area White Balance” button (shown at left) then click and drag the mouse in 
the preview window to define the area.  Recommended areas have an even 
coloration consisting of light or gray pixels.  This option is available only while 
the video display is running. 

4.6.2.3 Gain (Monochrome Cameras only) 

Make the video stream appear darker or lighter by moving the Gain slider or entering a 
value in the box at the end of the slider bar.  Valid values range from 0.69 (dark) to 2.74 
(light).  Default:  PL-A661 camera—1.0; PL-A641 camera—2.0 

For monochrome cameras, this slider appears in place of the White Balance controls 
shown in Figure 4.2 (on page 16).    

4.6.2.4 Saturation (Color Cameras only) 

Increase or decrease the saturation value by moving the Saturation slider or entering a 
value in the box at the end of the slider bar.  Valid values range from Mono/Less color 
(PL-A662/PL-A642 cameras, respectively) (0) to Full color (1.99).  Default:  PL-A662 
camera—0.76; PL-A642 camera —0.55. 

Tip:  To view a fully monochrome preview image with a PL-A642 camera, go to the 
Options menu and select Set Preview Window, then choose Monochrome (see page 
31).  

4.6.2.5 Gamma  

Increase or decrease the gamma correction value by moving the Gamma slider or 
entering a value in the box at the end of the slider bar.  Valid values range from 0.01 to 
2.00.  To turn off gamma correction, enter a value of 1.  Default:  0.85. 
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4.6.2.6 Presets 

“Presets” are custom configurations of PixeLINK Capture settings.  When a preset is 
applied, the PixeLINK Capture controls change to the values stored in that preset.  See 
Figure 4.6, below. 

Figure 4.6 Presets 

Create a preset:  With PixeLINK Capture settings adjusted as desired,  click Save.  
Specify a name for the preset and click OK. 

Apply a preset:    Select the desired preset from the drop-down list.  The factory 
default settings can be applied by selecting Default. 

Delete a preset: Go to the File menu and select Delete Presets.  Choose the 
preset to be deleted and click Delete. 

Presets are shared with the PixeLINK Capture TWAIN interface (see Section 5, on page 37). 

PixeLINK Capture launches with the control settings that were in use when it (or the 
PixeLINK Capture TWAIN interface) was last closed.   

4.6.2.7 Focus Meter 

Of special interest to microscopists: 

For scenes that have a shallow depth of field, such as microscope slides, the Focus 
Meter located at the bottom of the PixeLINK Capture control window gives a general 
indication of the quality of the current image focus level as compared to the focus 
level of previous images.  Use the Focus Meter to assist in manual focusing of the 
image.   

As shown in Figure 4.7 (below), the black vertical bar shows the best focus achieved 
in recent images.  The red horizontal bar shows the current focus level.  To use the 
Focus Meter for manual focus, slowly sweep the focal plane of the image from too 
close to too far, and then adjust the focus until the red bar reaches the black bar. 

Figure 4.7 Focus Meter and Status Bar 
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To minimize the impact of the focus meter on the host processor, the focus meter only 
measures differences in the contrast of vertical lines in the image.  Images with only 
horizontal lines or features may cause the focus meter to show erroneous indications. 

Switching off the Focus Meter:  To reduce the demand on the computer’s processor, 
switch off the Focus Meter:  Go to the Tools menu and deselect Enable Focus Meter.   

 4.7 Capturing an Image 

Near the bottom of the PixeLINK Capture control window are the three buttons needed 
to capture an image (see Figure 4.8, page below).  Apply them in this order:   

1. “Save As”—Specify a name, location and type for the image file (page 23).   

2. “Settings”—Select the Capture Settings Options (page 23)   

3. “Snapshot” / "Start"—Capture single/multiple image(s) (page 27). 

Figure 4.8 Image Capture Controls 

4.7.1 “Save As” 

Click Save As, then specify a name, location and type for the image file (see Figure 4.9, 
on page 24).   

Four file types are available:   

• Windows Bitmaps (*.bmp)  [default] 
• Tagged Image File Format (*.tif) 

• Raw data (*.raw) 
• JPEG File Format (*.jpg) 

Click Save. 

4.7.2 “Settings” 

Click Settings to display the Capture Settings options shown in Figure 4.10 (on page 
25).  Select the desired options, described below.  When finished, click Close. 

Options: 

� Auto Increment File Name   
Add a four-digit suffix to the file name and automatically increment the suffix 
each time an image is captured (single or multiple frame capture).   
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Figure 4.9 Select File to Capture to 

� Preview Image After Capture  
Automatically display a captured image in a new, static window immediately after 
capture.   

� Capture Full Frame (1280 × 1024) 
Capture a full-frame image, regardless of the size of the preview image or the 
location of the preview image in the full field of view. 

� Apply Overlay On Captured Images 
Add a bitmap, such as a company logo or a timestamp, to the captured images.  
To specify the bitmap location, go to the Tools menu and select Set Bitmap 
Overlay (see page 32). 

Selecting this option does not superimpose the bitmap overlay on the preview 
window.  To do this, go to the Tools menu and select Apply Overlay to Image 
Preview (see page 31). 

This option does not apply to images captured in JPEG (.jpg) format. 
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Figure 4.10 Capture Settings 

About Bitmap Overlay Images: 

• The bitmap must be a .bmp file in 24-bit RGB format. 

• The overlay image is placed in the upper left corner of the frame.  

• Any white areas (RGB 255,255,255) in the overlay image are treated as 
transparent; that is, the preview image will show through them. 

• An overlay image will not be resized if the size of the preview image is changed.  
However, if the PixeLINK logo supplied with PixeLINK Captu e is used as the 
overlay image, the application will replace the current overlay image with one 
that is appropriately sized for the new preview image.  User-defined overlay 
images can be customized for each preview image size by using the same file 
naming conventions as indicated in Figure 4.13 (on page 32). 

r

� Save Images With 10 Bits/Pixel  
If the “Save As” file type is .tif or .raw, select this option to save the image in a 
10-bits-per-pixel format.  Otherwise, it will be saved in an 8-bits-per-pixel format.  
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� Image Enhancement 

Histogram Stretch—This option improves the contrast of “muddy” images by: 

1. Detecting the minimum and maximum pixel values in the input image,  

2. Calculating a linear conversion that maps the minimum intensity value to 
full black and the maximum intensity value to full white, and  

3. Creating an enhanced image by converting all of the pixels of the input 
image accordingly. 

This has the effect of stretching out the pixel values to the widest possible 
range, thereby increasing contrast in the image. 

Multiple Frame Capture—This option allows the image to be enhanced by using 
data from several sequential images.  To be effective, image enhancements 
involving multiple frame capture require that the subject be as still as possible 
for the duration of the image capture. 

If Multiple Frame Capture is selected, choose Sum or Average and the 
number of frames to process. 

Sum—Brighten and enhance contrast in an image taken in a dark 
environment by adding the pixel values in several frames.  

Average—Reduce the effects of noise in the image by averaging the pixel 
values over several frames. 

Number of Frames—Enter the number of frames to Sum or Average.  
Valid values range from 1 to 99 frames. 

Note:  

Unlike other PixeLINK Captu e settings, the effects of Image 
Enhancement options are not viewable in the preview window.  The 
calculations required for these advanced functions would slow down a 
real-time video preview.  Instead, they are performed as the image is 
captured to disk.   

r

� Time Lapse Capture 

Enable Time Lapse—Select to capture a series of still frames. 

When this option is selected, Auto Increment File Name is selected 
automatically, allowing captured images to be stored in sequentially 
numbered files.   

To allow new time-lapse image to overwrite the previous image, deselect 
Auto Increment File Name before capture.  This feature may be useful 
with a program that repeatedly polls a specific image file, such as a webcam 
script. 
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Auto Exposure Before Each Frame Capture—Select to apply Auto Exposure to 
each frame individually in a time-lapse capture.  This is useful when lighting 
conditions will change during the period of time-lapse capture. 

Capture One Frame Every—Enter the time period between captured frames 
(minimum of 1 second, maximum of 1000 hours) and select a unit of time 
(seconds, minutes or hours).   

For—Enter the total time to run the capture (minimum of 1 second, 
maximum of 1000 hours) and select a unit of time (seconds, minutes or 
hours).   

Note: 

Latencies (delays) inherent in the computer system can cause variations 
in the time periods between time-lapse captured frames. 

4.7.3 "Snapshot" / "Start" 

The button located at the bottom right of the control window is context-sensitive 
depending on whether a single frame or a multiple frame image capture has been 
specified. 

“Snapshot”—Single Frame Capture   
Click to save an image in the location specified in “Save As” (on page 23).  If 
Auto Increment File Name was selected in “Settings” (on page 23), the file 
suffix will increment by one.   

“Start”—Multiple Frame Capture 
Click to save multiple images (or a repeatedly refreshed single image) in the 
location specified in “Save As” (on page 23), according to the time options 
specified in “Settings” (on page 23).   

To switch the Snapshot sound on or off, go to the Options menu and select or deselect 
Sounds. 

 4.8 Capturing a Video Clip 

In addition to capturing still images as snapshots of the preview window, PixeLINK 
Capture can capture AVI-format clips from the preview window video stream.  

To capture a video clip:   
1. Go to the File menu and select Capture AVI.  This opens the Video Clip Capture 

box (Figure 4.11, on page 28). 
2. Specify the AVI filename, and either specify the number of frames to capture or 

select Capture frames until told to stop.  Note that the video data is not 
compressed, so, depending on the number of frames captured, the AVI file could 
be large.   
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3. Click Start Clip Capture.  

To stop a video clip capture already in progress:   

Click Stop Clip Capture.  

Figure 4.11 Video Clip Capture 

About Video Clip Capture: 

• The capture process is performed in two stages:  
� In the first stage, raw video data is stored to disk in a temporary file as it 

arrives from the camera.   
� Once the capture is complete, the temporary file is converted to AVI format.   

• No compression is performed in this process so image file sizes can be large.   

• The capture process will not start if there is insufficient disk space on the 
computer to store the final results. 

• There is no capability within PixeLINK Capture to play back the AVI file.  A third-
party application will be required to do this. 

 4.9 Status Bar 

The status bar runs along the bottom of the PixeLINK Capture control window (as shown 
in Figure 4.7, on page 22).  The name of the current capture file is shown on the left, 
and the actual acquisition frame rate is reported on the right (provided that the preview 
window is running).  The frame rate is given in frames per second (fps).  Note that the 
actual frame rate displayed by the preview window depends on the system capabilities, 
so for slower computers, the actual (displayed) frame rate may be less than the 
theoretical maximum. 
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 4.10 Menu Bar 

4.10.1 File Menu 

� Save Capture File As 
Set the name, location and type of the image capture file.  This is the same 
as clicking Save As in the control window.  For more information, refer to 
page 23. 

� Capture Settings 
Change the image capture settings.  This is the same as clicking Settings in 
the control window.  For more information, refer to page 23.  

� Capture 
Capture a still image or images.  This is the same as clicking Snapshot or 
Start in the control window.  For more information, refer to page 27. 

� Capture AVI … 
Capture a video clip in AVI format.  Select this option to specify the name of 
the AVI file and the number of frames to be captured in the clip, and start the 
clip capture.  For more information, see Section 4.8 on page 27. 

� Delete Presets 
Remove old or unused presets from list of available presets.  For more 
information about creating, applying and deleting presets, refer to page 22. 

� Exit 
Shut down PixeLINK Capture. 

4.10.2 Options Menu 

� Set Subwindow Position 
Reposition the image within the full field of view.  The current image location 
(that is, the subwindow) appears as a red frame superimposed on the full 
field of view from the camera.  Drag the frame to reposition the image, then 
release the mouse button to set the new location.  (See Figure 4.3 on page 
17.)  Default:  Center. 

Moving the image in this fashion simulates a digital pan-tilt function.   

This option is not available when the selected image size is 640 × 512 (Full 
FOV) or 1280 × 1024, since these resolutions represent the full field of view. 
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� Set Light Source (Color Cameras only) 
Correct image color according to the lighting conditions.  Select the option 
that most closely approximates the lighting conditions.  Options are:  
Incandescent, Fluorescent 1, Fluorescent 2, Outdoors. 
Default:  Incandescent. 

“Set Light Source” is independent of white balance correction.  The light 
source option is applied to the raw image data during translation of the data 
to the correct format for display and capture (that is, RGB format).  White 
balance is applied after this translation.   

� Set Flip Mode 
Reverse the image horizontally (“Horizontal Flip”), vertically (“Vertical Flip”) or 
both.  Default:  Both off. 

To rotate the image by 180 degrees, select both horizontal and vertical flip. 

� Set White Point (Color Cameras only) 
Select an off-white shade to be corrected to white in the White Balance.   

In “true” white, the colors red, green and blue are present in equal intensities 
and at their maximum values.  In an off-white shade, the intensities of these 
colors are not equal, or are equal but not at maximum (that is, gray).  
Manually selecting an off-white shade for the white point allows the red, 
green and blue intensities to be specified with greater precision for the White 
Balance color correction.  (For more information about White Balance, refer 
to Section 4.6.2.2 on page 20.) 

On the displayed color bar (see Figure 4.12, below), the current white point 
color is indicated by a red rectangle.  The rectangle with the “W” has a light-
gray background color with all three RGB components of equal intensity.  
Default:  Light Gray (RGB 242,242,242). 

To select a new white point, click one of the color swatch boxes.  Click 
Okay to save the selection.   

Figure 4.12 Select White Point Color 

� Restore Camera Defaults 
Restore PixeLINK Capture to its default settings.  See Appendix B (on page 
40) for more information. 
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� Set Preview Window to (PL-A642 Cameras only) 
Select a Color or Monochrome display for the video preview.  Since the 
Saturation function in the control window does not remove all color for the 
PL-A642 camera, use this option to view a fully monochrome preview image 
with this model (see Section 4.6.2.4, on page 21).  Default:  Color. 

� Set Video Preview Acceleration to 
Adjust the frame rate of the video preview by increasing or decreasing the 
camera’s clock speed according to the settings shown in Table 4.3 (below).  
On older computers, color bands may appear in the preview image due to 
data lost as the computer tries to keep up with the higher speed of the 
camera.  To remove these bands, reduce the video preview acceleration rate. 

Table 4.3 Video Preview Acceleration Settings 

 Clock Speed 

Setting PL-A661 and 
PL-A662 Cameras 

PL-A641 and 
PL-A642 Cameras 

Accelerated 16 MHz  24 MHz  
Standard 12 MHz 16 MHz 
Moderate 8 MHz 12 MHz 

� Reset Preview Window 
Restore the preview window to its default location and reset the preview 
window dimensions to correspond to the image size.   

By default, the preview window is the same size as the image.  However, the 
preview window can be resized using the usual Microsoft window handles or 
by clicking its Maximize icon.  This does not affect the dimensions of the 
image generated by the camera, so resizing the preview window can distort 
the appearance of the image or make it look pixilated (that is, it can look 
boxy, chunky or jagged).  It can also slow down the performance of the 
system.  Resizing the window has no effect on captured images.   

For more information about default values, see Appendix B (on page 40). 

� Sounds 
Switch the Snapshot sound on or off.  Default:  On 

� Always On Top 
Change the float setting of the control window.  When this is switched on, the 
control window remains on top of other windows on the computer desktop; 
otherwise, other windows can overlap it.  Default:  Off. 

4.10.3 Tools Menu 

� Apply Overlay to Image P eview r
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Superimpose a bitmap, such as a company logo or a timestamp, on the 
preview window.  To specify the filename and location of the bitmap, use 
“Set Bitmap Overlay” (also in the Tools menu—see below). 

Selecting this option does not superimpose the bitmap overlay on captured 
images.  To do this, in the control window click “Settings”, then select 
Apply Overlay On Captured Images (see page 23).   

� Set Bitmap Overlay  
Specify the name and location of the bitmap overlay file (see Figure 4.13, 
below).   

About Bitmap Overlay Images: 

• The bitmap must be a .bmp file in 24-bit RGB format. 

• The overlay image is placed in the upper left corner of the frame.  

• Any white areas (RGB 255,255,255) in the overlay image are treated as 
transparent; that is, the preview image will show through them. 

• An overlay image will not be resized if the size of the preview image is changed.  
However, if the PixeLINK logo supplied with PixeLINK Captu e is used as the 
overlay image, the application will replace the current overlay image with one 
that is appropriately sized for the new preview image.  User-defined overlay 
images can be customized for each preview image size by using the same file 
naming conventions as indicated in Figure 4.13 (below).  

r

Figure 4.13 Select File to Use as Bitmap Overlay 

� Create/Apply Flat Field Correction 

Flat Field correction is used to correct for non-uniform lighting, optics, fixed 
pattern noise and pixel response non-uniformity.  The calibration process 
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involves two steps: capturing a dark image at the desired exposure time and 
then capturing a bright image under the lighting conditions to be used but 
where the sample has been removed and the image made as consistent as 
possible. 

To use flat field correction (FFC):   

Create FFC:  Select Create/Apply Flat Field Correction and follow 
the on-screen instructions.  (You will be asked to turn the 
illumination source off and on while sample images of the 
background are being captured.)  When finished, the flat 
field correction will be on.  

Turn off FFC:     Suspend the use of FFC by selecting Turn Off Flat Field 
Correction (also in the Tools menu—see below).  The 
FFC is not destroyed and can be turned on again.   

Turn on FFC:     Resume the use of FFC by selecting Turn On Flat Field 
Correction (also in the Tools menu—see below).   

Delete FFC: Permanently disable the current FFC by reselecting 
Create/Apply Flat Field Correction. 

� Turn Off (or Turn On) Flat Field Correction 
Suspend or resume the current Flat Field Correction (FFC). 

Note: 

Flat Field Correction can cause artifacts in the image if: 
• the background image is highly non-uniform, or 
• the camera detects illumination while the dark frame is being captured.   

� Enable Focus Meter 
Switch the Focus Meter on or off.  For more information about the Focus 
Meter, see Section 4.6.2.7 (on page 22). 

4.10.4 Help Menu 

� View User’s Manual 
Open this document in Adobe Acrobat Reader. 

� Flat Field Cor ection Procedure r
Display the instructions for applying Flat Field Correction. This option is 
available in the Tools menu (see Section 4.10.3, on page 31). 
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� About PixeLINK Capture … 
Display information about the camera and the software, as shown in Figure 
4.14 (on page 35).  For technical support or servicing queries, have this 
information available. 

Imager Type—  The type of imager e.g. PixeLINK 1394 Camera (Color)  
Serial Number—The serial number of the camera. 
FPGA Version—The version of the FPGA hardware in the camera. 
Firmware Version—The version of the firmware in the camera. 
Driver Version—The version of the camera driver. 
API Version—The version of the application programming interface (API) 

used to create PixeLINK Capture.  
GUI Version—The version of PixeLINK Capture. 
GUI DLL—The version of the PixeLINK Capture DLL software  
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Figure 4.14 About PixeLINK Capture 

Note: 

PixeLINK Capture can control one camera at a time.  However, multiple 
cameras can be controlled simultaneously by other methods, such as 
opening PixeLINK Capture once for each camera or by using custom 
applications created with the PixeLINK Camera API (included in the 
PixeLINK Megapixel FireWire Camera Developer’s Kits). 

If several PixeLINK Capture control windows are open in a single 
session, the values saved for the next session are those from the last 
PixeLINK Capture control window to be closed in the current session. 
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 4.11 Keyboard Shortcuts 

Save time by using these Keyboard Shortcuts.  

Action  Shortcut 
Capture image CTRL-C 

or <space> 
Auto exposure CTRL-E 
Auto white 
balance 

CTRL-W 

 

The shortcuts are enabled when the control window is the active window. 
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555      
Using the Camera with TWAIN 

 5.1 Introduction 

Images can be captured directly from the camera into popular programs such as 
Microsoft Word, Adobe Photoshop and CorelDRAW using the PixeLINK TWAIN Interface. 

The image capture process with the PixeLINK TWAIN interface is simple, but the exact 
steps necessary to open a TWAIN interface are specific to each application.  Consult the 
application manuals and help files for instructions.  Often, applications regard TWAIN-
enabled devices (such as PixeLINK cameras) as being distinct from digital cameras, 
sometimes categorizing them as "scanners."     

 5.2 Using the Camera 

Make sure that the PixeLINK camera software is installed (see Section 2 on page 5), then 
follow the three steps listed below. 

1. Set up 
 Connect the camera and open your application.  Ensure no other program is 

accessing the camera.  

2. Open the PixeLINK TWAIN interface 
 This is specific to each application. Refer to the documentation and help for your 

application.  

3. Capture the image 
 Adjust image settings and capture the image (see page 37). 

 5.3 Capturing an Image 

The TWAIN preview and settings windows open by default when the TWAIN interface is 
activated (as shown in Figure 5.1, on page 38).  
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1. Adjut the image settings:  The functions accessible through the settings window 
perform in the same way as those in PixeLINK Capture, with the following 
exceptions: 

• No video clip (AVI) capture 

• Limited still image capture settings, with no time-lapse capture or image 
enhancement 

• No overlays or flat-field correction  

For a description of the functions, see Section 4 (on page 14).   Note that presets 
and the last-used configuration of settings are shared with PixeLINK Capture.  
The keyboard shortcuts also work with the PixeLINK TWAIN interface. 

To close the settings window, click Close.  The settings window can be reopened 
from the preview window by clicking Settings. 

2. Click Capture to acquire the image.   

In some applications (including Microsoft Word and CorelDRAW), the PixeLINK TWAIN 
preview window closes automatically.  In others (including Adobe Photoshop), the 
PixeLINK TWAIN preview window remains open for further image captures and must be 
closed manually by clicking Close. 

Disable automatic display of settings panel:  Select this option to prevent the 
settings window from opening automatically each time the PixeLINK TWAIN interface is 
activated.  This is useful if many images are being captured with the same settings.   

Figure 5.1 PixeLINK TWAIN Preview and Settings Windows 

Preview Window 

Settings Window
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Appendix A. Glossary 
 1394 Short for the IEEE 1394 digital bus protocol (also known as 

FireWire, a trademark of Apple Computer, Inc.) 

 .avi, AVI Microsoft Windows video file format (Audio Video Interleaved) 

 .bmp, BMP Bitmap file 

 CD Compact Disc 

 Enhanced Control A set of features of PixeLINK Imaging Modules related to electrical 
control of the camera through a special connector 

 FireWire Apple Computer’s trademark for the IEEE 1394 digital bus protocol  

 FOV Field of View (FFOV—Full Field of View) 

 fps Frames Per Second 

 GUI Graphical User Interface 

 IEEE Institute of Electrical and Electronics Engineers 

 

 .jpg, JPEG Graphics file type/extension (lossy compressed 24-bit color image 
storage format developed by the Joint Photographic Experts Group) 

 MB Megabyte 

 MHz Megahertz 

 OHCI Open Host Controller Interface 

 PC Personal Computer 

 PCI Peripheral Component Interconnect 

 preview window The window used to display images on the screen.  The default size 
is the same number of rows and columns as in the image. 

 RAM Random Access Memory 

 RGB Standard for encoding color images (Red, Green, Blue) 

 ROI Region of Interest.  The subwindow on the image sensor where 
data will be collected. 

 ROM Read-Only Memory 

 sensor The Camera’s image sensing chip  

 subwindow The area exposed on the imager (not a window defined for viewing 
the image on the screen)   

 .tif, TIFF Tagged Image File Format 

 TWAIN An image capture standard typically used as an interface between 
image processing software and a camera or scanner 

IR Infra-red 
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Appendix B. PixeLINK Capture 
Presets and Defaults 

Property ated 
d applied when a preset is used. 

Default Value: operty when the camera is first installed, the preset 

Restore Camera D ra Defaults will 
restore the 
type.  (Se

iew Window will restore 
 values.  (See Section 4.10.2, page 29). 

 

:  All of the Camera properties listed below are stored when a preset is cre
(see Section 4.6.2.6, page 22) an

  The value of the pr
has not been set or the registry has been cleared. 

efaults:  Selecting Options Æ Restore Came
checkmarked properties to the default values, sometimes based on sensor 

e Section 4.10.2, page 29). 

Reset Preview Window :  Selecting Options Æ Reset Prev
the checkmarked properties to the default

Table B.1  PixeLINK Capture Presets and Defaults

Release 3.2 PixeLINK  

Property Default Value Restore 
Camera 
Defaults 

Reset  
Preview 
Window 

Control Window 
State of the preview – stopped, Playing 
playing, or paused   

Image size 640 × 480   
Exposure (in millise meras: 50 ms 

s:  25 ms   conds) PL-A661 and PL-A662 Ca
PL-A641 and PL-A642 Camera

AE On (Continuous auto exposure)  No   
White Balance Slider  Midpoint   
White Balance Blue Gain Value PL-A662 Cameras: 1.96x 

PL-A642 Cameras:  2.8x   

White Balance Green Gain V
  2.0x  alue PL-A662 Cameras: 1.0x  PL-A642 Cameras:

White Balance Red Gain Value PL-A662 Cameras: 1.09x  PL-A642 Cameras:  2.3x  

Gain (Mono) PL-A661 Cameras: 1.0x 
PL-A641 Cameras:  2.0x   

Saturation PL-A662 ras: 0.76 
eras:  0.55   Came

PL-A642 Cam
Gamma 0.85   
“Save As” Dialog Box 
Location of capture file  “My Pictures” folder   
Name of capture file   “data” + file format   
File format   .bmp 
“Capture Settings” Dialog Box 
Auto Increment File Name No   
Preview Image After Capture No   
Capture Full Frame  No  
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Property Default Value Restore 
Camera 
Defaults 

Reset  
Preview 
Window 

Apply Overlay On Captured Images No   
Save Images with 10 Bits/Pixel No   
Image Enhancement:  

Histogram Stretch No   

Multiple Frame Capture No   
Sum/Average Sum   

Number of Frames 1   
Time Lapse Capture: 

Enable Time Lapse 
No   

Auto Exposure Before Each Frame No 
Capture   

Capture One Frame Every (Number of 
seconds between captures) 

6   

“For” (Total duration of time lapse 60 
captures, in seconds)   

Options Menu 
Set Subwindow Position: 
 Start   Column Centered   
Set Subwindow Positio   n:   Start Row Centered  
Set Light Source Incandescent   
Horizontal Flip No flip   
Vertical Flip No flip   
White point RGB value for Blue 242   
White point RGB value for Green 242   
White point RGB value for Red 242   
Set Preview Window to Color   
Set Video Preview Acceleration to Standard 

(PL-A661 and PL-A662 Cameras: 12 MHz 
PL-A641 and PL-A642 Cameras: 16 MHz) 

  

Reset Preview Window:   
Height ght 

 
Image hei   

Width Image width   
Top  c window   Same top position as ontrol 
Left l w  Just to right of contro indow   

Always On Top  No   
Tools Menu 
Apply Overlay to Image Preview  No  
Set Bitmap Overlay (Name of the 

lay file)  
p appropriate   bitmap over

“PixeLINKLogo” (.bm  file of 
size for the image) 
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Appendix C. oubleshooting 
, please follow these steps: 

1. D , it five seconds, then reconnect it. 

2. Review the relevant sections of the documentation, including the common 
solu e ns below. 

3. Chec eb site (http://www.pixelink.com/) for new software or 
li e technical information such as the F equently ked 

e problem you are experiencing, noting any warning or 
a ppear during operation 

ial number and other identifying information at hand.  The 
er can be found on bottom of the camera; other information can be 

K Capture  

r  r

Tr
When troubleshooting your camera

isconnect the camera  wa

tions listed in the s ctio

k the PixeLINK W
firmware, and for app cabl r As
Questions List or Application Notes. 

4. Carefully document th  
error messages that m

e your camera's ser

y a

5. Hav
serial numb
found on the “About” screen in the PixeLIN

6. Contact you  PixeLINK eseller. 

 rror C.1 Installation E

If you receive the error message shown in Figure C.1 (below), logout of the system and 
h adm r privileges.  Reinsert the Kit CD

Fig

login using an account wit inistrato .  

ure C.1  Installation Error Message 

 C.2 ol of a Camer pplications Contr a by Multiple A

A camera cannot be controlled by more than one application at once.   

 C.3 Camera Not Detected Properly by Windows 

If you plugged in the camera before installing the Kit software, Windows might not have 
detected the camera or the driver might not have been installed. 
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To remedy this situation, disconnect the camera, wait five seconds, then reconnect it.  
re to check 
of Windows 

 Panel.  

4) evice Manager. 

alled correctly (see Figure C.2, below).   

If th

2) 
p ar in the program list, the 

 and should be reinstalled.) 

3) Follow the installation directions in Section 2.2.2 (on page 7). 

the w t failed to install the new driver, verify that you are using 
e of t operating systems (see Section 1.3, on page 2). 

vice Driver 

Windows should automatically detect the connection.  The following procedu
the status in the Device Manager applies to Windows 2000.  Other versions 
have similar procedures.  To check the status:   

1) Connect the camera. 

2) Click the Windows Start button.  Select Settings Æ Control

3) Double click System. 

Choose the Hardware tab, then click D

5) One of the categories should be Imaging Device or Imaging Devices.  Click 
the plus sign to the left of the category name.  If “PixeLINK FireWire Camera 
Release 4” appears, the driver is inst

e above procedure does not work,  

1) Disconnect the camera. 

Uninstall the PixeLINK software according to the instructions in Section 2.3 (on 
page 9).  (If your PixeLINK Kit software does not a pe
program is not installed properly

If izard informs you that i
on he supported Windows 

Figure C.2 Checking the Imaging De
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Appendix D. PixeLINK Imaging 
Module and Camera Models 

Bec e Megapixel 
Fire e amera models PL-A631 though PL-A662.   

aus  PixeLINK software is backward-compatible, it works with all PixeLINK 
Wir  Imaging Module and C

 D.1 Functional Relationship Between PixeLINK Imaging Modules and 
Cameras 

A PixeLINK imaging module (board-level camera) can perform all of the functions of the 
equ e mera (that is, a PL-A654 color imaging module can do 
the 
module
and trig

For  Enhanced Control 

ival nt model of PixeLINK ca
same things as a PL-A662 color camera).  However, certain models of imaging 

 offer Enhanced Control functions not available in the cameras, such as shutter 
ger controls. 

more information about PixeLINK imaging modules, including the
header, please refer to the Megapixel FireWire Camera System Guide for PL-A630 to PL-
A660 Series Cameras or contact PixeLINK (see page 45). 

 D.2 Relating Imaging Module Models to Camera Models 

Table D.1  PixeLINK Imaging Module and Camera Models 

Type 
Imaging  
Module 
Model 

 
Performs the 
functions of 
Camera Model Color Monochrome Enhanced 

Control 

PL-A654 PL-A662    
PL-A653 PL-A661    
PL-A634 PL-A642    
PL-A633 PL-A641    
PL-A632 PL-A642    
PL-A631 PL-A641    
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Technical Support 
Tech Notes 

Tech Notes on a variety of topics are available on the PixeLINK Support Site, at 
http://support.pixelink.com/. 

Download the Latest Software and Firmware  

We recommend that you check http://support.pixelink.com/ regularly for the latest 

Technical Questions 

new software and firmware; 

ncing, noting any warning or 
error messages that may appear during operation. 

• Have your camera's serial number and other identifying information at hand.  The 
xeLINK Capture” 

screen. 

PixeLINK Customer Support 
support@pixelink.c

versions of your PixeLINK software and firmware.    

Please follow these steps before contacting our technical support team: 

• Review the relevant sections of the documentation. 

• Check the PixeLINK Support Site for  

o 

o applicable Tech Notes. 

• Carefully document the problem you are experie

serial number can be found on the camera and the “About Pi

Email:  om
PixeLINK Support Site ://su .com:  http pport.pixelink /

PixeLINK Main Site ://w /:  http ww.pixelink.com
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Index 
Acceleration set —18, 19, 31, 41 
Accessories—3 
Adobe Photosho
AVI file format—
BMP files—39 
Cam
Con
CorelDR
Exposure
Exposure, auto
FireWire connectors—iii, 5, 10, 12 
Flip—
Focu
Full 
Gamma— ,
Histogram stre
Image si 1
Image, repositionin
Imaging Modules—1, 4, 12, 44 
Installation—2, 5, 8, 42 
IR filter— 1

JPEG files—14, 23, 24, 39 
Lenses—3, 10, 12, 20 

Multiple frame capture—26, 27, 41 
PixeLINK Capture defaults—30, 40 

1, 3, 5, 6, 12 
15, 22, 29, 38, 40 

38, 39, 40, 41 
19, 21, 31, 40 

Serial number—34, 42, 45 
Snapshot sound, switching on or off—27, 31 

re—26, 41 
Tripods—12 
Troubleshooting—42 
TWAIN—1, 2, 3, 15, 22, 37, 38, 39 
Video compression—28 
Video source—30, 41 

 
 

ting (clock speed)

p—1, 3, 37, 38 
39 

Microsoft Word—1, 3, 37, 38 

era models—1, 14, 44 
tinuous auto exposure—19, 20 

Power—
Presets—

AW—1, 3, 37, 38 
—1, 14, 16, 18, 19, 20, 27, 40 

matic—19, 27, 41 

Preview window—14, 15, 17, 18, 21, 24, 26, 27, 28, 
31, 32, 

Saturation—18, 

30, 41 
s meter—22, 23, 33 

field of view (FFOV)—17, 18, 24, 29, 39 
Technical Support—45 
TIFF files—14, 23, 25, 39 

18  21, 40 Time lapse captu
tch—26, 41 

ze— 4, 17, 18, 19, 25, 29, 31, 32, 40 
g in the full field of view—18, 29 

10, 3 White balance—1, 16, 18, 20, 21, 30, 40 
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